
GETTING STARTED

HP OpenView Storage
Data Protector Media Operations 6.0

This guide describes installing, starting and configuring Media Operations.

© Copyright 2006 Hewlett-Packard Development Company, L.P.
Part number: B6960–96020
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Product names mentioned herein may be trademarks of their respective 
companies as reflected by an associated footnote.The information in this 
document is subject to change without notice.
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Windows pre-installation survey

Describe your current backup scenario
Detailed information will allow the installation and configuration to fit 
your current practice more closely.
1. What is your current backup application? ______________________
2. What is your backup routine? Daily, weekly, monthly? ___________
3. Do you archive data? If so, for how long? ______________________ 
4. What type of media do you use? Tape, Optical, File? ____________
5. How many pieces of media do you use?

6. How do you manage the movement of media?
Manually �  Through automated devices �

7. Do you send media to an offsite storage facility? Yes � No �
If so, how often?  __________________________
What is the facility information?

Name: _________________________
Address: _________________________
Account number: _________________________

8. What is your retention policy? ________________________________
9. Which media do you keep onsite? ____________________________
10.Which media do you send offsite? ____________________________
11.Do you keep any backups in the device? Yes � No �
12.Do you have multiple media pools? Yes � No �

System requirements
For more details, see Prerequisites in the Installing Media Operations 
section of Chapter 2, “Installing and Licensing” of the HP OpenView 
Storage Data Protector Media Operations User’s Guide.
Media Operations server

CPU: minimum 500 MHz Pentium III (HP highly recommends a 
dual-processor machine)
RAM: minimum 256 MB
Free disk capacity: 500 MB
A local printer must be configured on the server. The printer does not 
need to be physically attached, though you will need one for full 
product functionality.

daily: ____ weekly: ____ monthly: ____ in total: ____
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XML Gateway

The XML Gateway is a standalone package that integrates with the 
backup manager. The gateway can be installed on one of the following:

The same server as the backup manager
Another system within the same firewall zone as the backup 
manager*
The Media Operations server system. In this case, a dual processor 
system is highly recommended for performance reasons.*

*Not applicable for using Veritas NetBackup, when the XML Gateway 
must be installed on the NetBackup Master Server.

NOTE: If you have a Data Protector Manager-of-Managers (MoM) in 
your installation, you should install the XML Gateway on the same 
server.

The XML Gateway will run on Windows 2000, Windows 2003, HP-UX, 
Solaris and Linux.
It integrates with the following supported backup managers:
• HP OpenView Storage Data Protector 5.x, 6.0
• Veritas NetBackup Data Center 4.5
• Veritas NetBackup Business Server 4.5
• Veritas NetBackup Server 5.0, 5.1
• Veritas NetBackup Enterprise Server 5.0, 5.1
Media Operations Manager

The Media Operations Manager, which forms the user interface, is 
automatically installed on the Media Operations Server. You can also 
install it on supported Windows client systems.
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Installation checklist

NOTE: On a Windows system, you can find network configuration 
information by running “ipconfig /all” from a command 
window.

1. Identify the backup manager
a. What is the backup manager (for example: Data Protector Cell 

Server)? __________________________
— System IP address: __________________________
— Host name: __________________________
— DNS extension: __________________________

b. Will the Media Operations Server be in the same subnet as the 
backup manager?  Yes � No �

c. Is the backup manager behind a firewall?  Yes � No �
The presence of a firewall requires configuration Proxy 
information for correct XML Gateway function.
If yes, what is the proxy 
information? __________________________

d. Identify where the XML Gateway will be installed
— System IP address: __________________________
— Host name: __________________________
— DNS extension: __________________________

2. Identify clients on which the Media Operations Manager will be 
installed

System IP Address Host Name DNS Extension

Client 1:

Client 2:

Client 3:

Client 4:
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10-minute installation guide

Installing Media Operations

NOTE: Before you install Media Operations, a local printer must be 
configured on the server. A printer does not need to be physically 
attached at this stage, though you will need one for full product 
functionality.

1. Insert the installation DVD or CD and run setup.exe from the 
\server directory. This launches the InstallShield wizard.

2. Click Next to continue the installation.
The license agreement is displayed.

3. Read the agreement carefully and click Yes to accept.
4. Enter the destination for the server program files.

The default location is:
C:\Program 

Files\Hewlett-Packard\DataMgt\MediaOps

NOTE: The Media Operations Server’s database files are located in 
the same destination directory as the Media Operations Server 
program files. Database files can grow to a large size, so select a 
location for the Media Operations Server files that can accommodate 
this growth, for example, 200 MB for every 10,000 tapes.

• Click Next to accept this destination.
• Click Browse to select a different location from the drop-down 

window.
5. Enter the destination for data management communications services 

files.
The default location is:

C:\Program 
Files\Hewlett-Packard\DataMgt\DMComms.
• Click Next to install to this location.
• Click Browse to select a different location from the drop-down 

window.
6. Create the Media Operations Administrator.

a. Enter the Administrator name for the Media Operations Server 
and database. This user is unique to the database.

b. Enter a Password of 10 characters or less for this user.
c. Make a note of the name and password. You will need them later 

in the configuration and for future use.
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7. Click Next to proceed or Back to change your settings.
The application is installed.

8. Read the Read Me file or click Finish to exit the installation wizard.
The Media Operations Server installation is now complete. There is now 
a Media Operations Manager icon on your desktop and an HP Media 
Operations option in your Start -> Programs menu.

Installing XML Gateway on Windows

NOTE: The XML Gateway is also available for HP-UX and Linux. See 
Chapter 2 in the HP OpenView Storage Data Protector Media 
Operations User’s Guide for details.

1. Insert the installation DVD or CD and run setup.exe from the 
\xmlgw\windows directory.
This launches the InstallShield wizard.

2. Click Next to continue the installation.
The license agreement is displayed.

3. Read the agreement carefully and click Yes to accept.
4. Enter the destination for the XML Gateway files.

The default location is:
C:\Program 

Files\Hewlett-Packard\DataMgt\XMLGW

• Click Next to accept this destination.
• Click Browse to select a different location from the drop-down 

window.
5. Enter the destination for data management communications services 

files.
The default location is:

C:\Program 
Files\Hewlett-Packard\DataMgt\DMComms

• Click Next to accept this destination.
• Click Browse to select a different location from the drop-down 

window.
6. Click Next to proceed or Back to change your settings.

The application is installed.
7. Read the Read Me file or click Finish to exit the installation wizard.
The installation is now complete. No icon or program group is created.
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Installing the Media Operations Manager
The Media Operations Manager can be installed on any supported 
client system. This graphical user interface provides access to the Media 
Operations Server, even when located at another site.

NOTE: A copy of the Media Operations Manager is included with the 
Media Operations Server so you do not need to install it on the server 
system.

Before you install Media Operations, a local printer must be configured 
on the server. The printer does not need to be physically attached at this 
stage.
1. Insert the installation DVD or CD and run setup.exe from the 

\client directory. This launches the InstallShield wizard.
2. Click Next to continue the installation.

The license agreement is displayed.
3. Read the agreement carefully and click Yes to accept.
4. Enter the destination for the Media Operations Manager files.

The default location is:
C:\Program 

Files\Hewlett-Packard\DataMgt\MediaOps

• Click Next to accept this destination.
• Click Browse to select a different location from the drop-down 

window.
5. Click Next to proceed or Back to change your settings.

The application is installed.
6. Read the Read Me file or click Finish to exit the installation wizard.
The installation is now complete. There is now a Media Operations 
Manager icon on the desktop and an HP Media Operations option in 
the Start -> Programs menu.

Media Operations services
Once installation is complete, Media Operations runs as three services.
Click Start > Settings > Control Panel > Administrative Tools > Services.
Scroll down the list of services and locate the following:

HP Data Management Comms Service (installed on the XML 
Gateway system and Media Operations server)
HP DP XML Gateway Service (installed only on XML Gateway 
systems)
HP Media Operations Server (installed only on the server)
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15-minute configuration guide
These instructions guide you through the minimum configuration options 
that you need for basic use or demonstrations. See the HP OpenView 
Storage Data Protector Media Operations User’s Guide for details of all 
available options.

Launching the Media Operations Manager and logging in
1. Launch the Media Operations Manager.

Double-click the Media Operations Manager icon on your desktop.
A dialog box is displayed with three tabs: Recent, TCP/IP and 
Custom.

2. Connect to the Media Operations Server.
If the server and the manager GUI client are on the same subnet:
a. Click the TCP/IP tab.

A list of all the Media Operations Server databases is displayed 
along with the server host name.

b. Highlight the host name of your Media Operations Server and 
click OK.

If the server and GUI client are on different subnets:
a. Click the Custom tab.
b. Enter the network name (such as sys1.abc.com) or the IP 

address of the Media Operations Server.
c. Enter the description for this server manually.
The User Log In box is now displayed.

3. Log in as Administrator.
a. Enter the Administrator name created during installation of the 

Media Operations Server.
b. Enter the Password for the administrator.
c. Click on Log In.

The Media Operations Manager main screen is displayed.

Configuring Media Operations
Configure the Media Operations Server and XML Gateway using the 
Media Operations Manager screen. This has two windows:
• Left: the Topic Selection window on the left.
• Right: the Main window, with information and configuration options.
1. Run the Add Site Wizard.

If this is the first time the GUI has been launched:
The Add Site Wizard is displayed in the Topic Selection window.
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For subsequent site configurations:
a. Scroll down the Topic Selection window and double-click Site 

Management.
The Main window displays Add, Add Many, and Edit options.

b. Click Add to define your site.
See the User’s Guide for detailed information on defining sites.

2. Enter details of the site in the Add Site Wizard window:
• Site Name. Type the name for the site, such as a room, building 

or city.
• Site Address (optional). Type the physical address of the site.
• Primary Contact (optional). Enter the name of the primary contact 

at the site.
3. Create a Vaulting Policy.

Vaulting policies define where media is retained and for how long 
(see the User’s Guide glossary). Each site must have at least one 
vaulting policy.
a. Type a Name for your policy, such as “Month End,” and click 

Next.
b. Select Template.

Select or define a policy template, to define media usage and 
security.

c. Click the down arrow at the end of the first field to see template 
definitions. Select the template that best matches your policy. The 
policy rules are displayed in the text window.

d. Click Next to use the template.
(Note: If you want to use Add Template, see the User’s Guide.)

4. Edit the Vaulting Policy Cycles.
Alter the template options to customize specific cycle actions, define 
vaults, and create offsite vendors within a policy. Highlight vaulting 
policies that have a location type of Vault or Offsite Vendor and click 
Edit. You can enter and alter the following:
• Day Number. The number of days to wait after a backup before 

moving media to its destination.
— Vault No Later Than. Flags media you want moved to its 

destination earlier than the Day Number.
— Vault When Full. Flags media you want move to its destination 

when it is full, even if the Day Number has not been reached.
• Description. Describes the destination of media for the vaulting 

policy.
• Destination Location. Whether media will move to a device or 

scratch pool, or be checked out, or go to an offsite vendor.
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• Destination Site. The site for the media destination. If you are 
moving media to another Media Operations site, the site must be 
configured.

• Vaulting Days. When media movement is allowed within the 
cycle.

5. Define the Vault.
Click Add Vault to define your own site vault specifications.
The Onsite Vault Management window is displayed. There are four 
tabs, of which the Info tab is open. To define the physical 
characteristics of the onsite storage vault, enter the following 
information:
• Vault Name. Used to identify the vault. Type a name and click 

Next.
• Onsite Priority. The priority of the vault when two or more onsite 

vaults are in use. Media is relocated to the vault with priority 1 
until the vault is full, then to the vault with priority 2, and so on.

• Offsite Priority. The priority of the vault when two or more offsite 
vaults are in use.

• Physical Location. The location of the vault, such as building, 
floor, room, desk or cabinet.

6. Define the Vault Layout.
To define the vault’s physical characteristics:
a. Click the Layout tab.
b. Click Auto-Create Layout.

Note: You can also use Add Cabinets, but this is slower because 
you must enter each characteristic. For details see the User’s 
Guide.

c. Enter the following details:
— Starting and ending cabinet count. The number of cabinets 

(1–5) in the vault.
— Starting and ending drawer count. The number of drawers 

(01–15) in each cabinet.
— Starting and ending row count. The number of rows in each 

drawer.
— Starting and ending slot count. The number of media slots 

(01–25) in each row.
— Media per slot. The number of media in each slot.
— Vault Slot Type. The type of media stored in each slot. Select 

from the drop-down list.
d. Click on Create to return to the Layout tab.

You will see your newly created cabinet.
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e. Click on OK to save the vault layout and return to the Vaulting 
Cycle Action tab of the Site Definition Wizard.

f. Click OK to return to Add Site Wizard window.
g. Click Next.

7. Save your Configuration.
You can save configuration information and return to it later, or 
choose to add the Backup Manager.
Select Yes Add Backup Manager and click Finish.

8. Add the Backup Manager.
The Backup Manager is the computer system and backup application 
used to administer backups. Select the manager from the drop-down 
list.
NOTE: See the User’s Guide for information on the option Other.
Enter the following:
• Backup Manager Name (required). The DNS name of the Backup 

Manager, such as NSSO1.OpenView.com.
• Backup Manager Host System. The primary network name of the 

host system that is running the Backup Manager. Select
<Use Backup Manager Host System>. This allows Media 
Operations to use the DNS name of the DP cell manager.
Click Next.

• Username. The name of a user Backup Manager can 
authenticate. Use uppercase letters. The user must be configured 
within Backup Manager. Review the list of users within Backup 
Manager to ensure that:
— the username exists,
— the username and host name attributes match the computer 

name of the Media Operations server, or that the computer 
name is set to <Any>.

• Domain. For Windows, either the domain name or host name:
— If the Windows user is a domain user, such as 

EUROPE2\NSSO1, enter the domain name (EUROPE2).
— If the user is not a domain user, enter the host name (NSSO1).

• Port Number (only relevant when the Backup Manager is Data 
Protector or Omniback). Used to communicate with the Backup 
Manager. Data Protector typically uses port 5555. Click Next.

• Synchronization Schedule. Designated times for the Media 
Operations Server to communicate and synchronize its database 
with the Backup Manager. Check the appropriate time.
Note: Times are displayed in Military Time (such as 1500 for 
3:00 pm).
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• Enable Location Updates. Updates the Backup Manager “location 
field” when moving media based on policies.

• XML Gateway Location. Select the option that indicates where the 
XML Gateway will be installed and operating.

• Proxy Server Information. Select the option that details whether 
the Backup Manager and Media Operations Server are located 
in the same or a different domain.

• Same Domain Information. If the Backup Manager and Media 
Operations Server are in the same domain, select Proxy Not 
Required and click Next.

• Different Domain Information. If the Backup Manager and Media 
Operations Server are in different domains, select Proxy Server 
Required and click Next.
Enter the following information from your 
network administrator:
— Proxy Type
— Proxy Port
— Proxy Host Name
— Proxy Username
— Proxy Password

9. Finish.
Click Finish. The Media Operations Server asks the Backup Manager 
for information. If information is displayed, the configuration is 
successful. If not, errors will be displayed.

You have now completed configuring the Backup Manager.
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